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about us

In 1978 when Winestate Magazine began it was to set the
benchmark for other industry publications to try and match.

Several decades later, many of those other publications have
been and gone while Winestate has remained and is the
leading independent Wine Magazine in Australia.

Going back a over 30 years, Australia had |71 wine and
brandy producers. It was not impossible for a serious taster
to get to know most of them. Today, Australia has more than
1,800 wineries. That's more than ten times as many. This is
why we at Winestate Publishing employ informative quality
journalists and feature columnists who are knowledgeable in
the goings on of each particular wine region. They give our
publications an array of credible and interesting articles on
upcoming events, personality profiles, new and old wineries,
cellar doors and restaurants and other interesting and
informative topics all in an easy to read format.

We have a number of different publications particularly
tailored to suit different market segments:

* Winestate Magazine
* The Wine & Spirit Insider

* Winestate On -line
(Our Consumer Website www.winestate.com.au)

Winestate magazine is a consumer wine buying guide aimed
squarely at those looking to buy wine for their home cellar,
their restaurant or for their bottle/liquor store.

Its primarily focus is on the Australian reader and has a
circulation base of 25,000 with an estimated readership over
100,000. Its readers are influencers within their peer groups
and as such the magazine impacts on a wide-ranging audience.
Particular areas of influence include wine buyers, wine
investment, wine tourism and the restaurant scene.

This magazine is sold and distributed through newsagents and by
subscription to readers across the globe and through selected
liquor retailers across Australia. Winestate’s sales concentration
is in the larger cities and their high-income suburbs.

Regular Sections.

* Grapevine / Dining stories & latest reviews from around
Australia & New Zealand.

* Wine Tutor

* Wine Investment & Collecting

* What's its Worth — Auction Section.

* New Releases

* Varietal Style tastings (eg: Shiraz etc)

* Regional tastings (eg: Barossa, Hunter Valley etc.)

* Wine & Spirit Insider — Beers, Spirits & Value Wine Buys.

* Wine Travel & Tourism

WINESTAIK

MAY 1978 80¢
| Winesin
restaurant

How to
taste wines

018 GALLERIE, TANSNLA

Winestate’s first issue May 978!



WINESTATE,

NUMBER ONE
selling magazine in wine & spirit category

Winestate Magazine is distributed in Australia & New Zealand
through Gordon and Gotch. Australia’s largest independent
magazine distributor. Servicing newsagents and newsstands
using their expertise in distribution.

They have the largest range of magazines in Australia, and
provide this service to over 300 publisher clients through
more than 8000 retail outlets. Over 190 million magazines are
distributed into the Australian marketplace each year, which
has a total retail value of over $600 million.

Gordon and Gotch have an extensive database of
approximately 3400 different magazines across a broad range
of categories. Each month their warehouses around Australia
distribute over |7 million magazines.

Winestate for many years has been the number one selling
magazine in the Wine & Spirit category for Gordon & Gotch
on the news stands.

wine & spirit category

Winestate Magazine Ranked Number |
in Wine & Spirit Category

food & wine category

”

"

Winestate Magazine Ranked Number 6
Gordon and Goich in Food & Wine Category

A PMP GROUP COMPANY

Note from Gordon & Gotch

In relation to the Category info, we have
provided both the main category (Food &
Wine) and the sub category (Wine & Spirits).
You will see notated on each category
where Winestate is ranked in the category.

It should also be pointed out, these are of
course Gordon & Gotch titles only and not
reflective of the entire Australian market.
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sponsors events globally

As the world’s biggest buying guide to Australian & New
Zealand Wines our aim is to promote those wines that
achieve the highest results in our tastings.

People are quite often surprised at the amount of work we do
behind the scenes to not only promote ourselves through the
many wines submitted and published in our magazine, but also
to support & sponsor other exhibitions held around the world.

Over the past few years we have supported events such as
Wine Australia and been media partners with the Good Food
& Wine Show and the Adelaide Festival of Arts. Every year we
send one of our team to Vinltaly and showcase a selection of
wines from across Australia and New Zealand at the World's
Largest Wine Show!

Recent sponsorships and media partnerships include the:

Wine & Spirit Asia Singapore
www.foodnhotelasia.com

Hong Kong International Wine & Spirits Fair
www.hktdc.com

Vinitaly
www.vinitaly.com

Adelaide Festival
www.adelaidefestival.com.au

Top Wine China
www.topwinechina.com

By supporting these exhibitions and other promotions we believe
that it is doing our bit to help keep the interest in Australian

& New Zealand wines to the fore and, of course, it helps the
profile of Winestate to be seen at these prestigious events.

We are delighted that our magazine reaches these important
overseas buyers and that they can use Winestate to help with
their buying decisions including keeping abreast of the new
wines coming onto the market.



public tasting events

Winestate is a sponsor of the National Wine Centre and
holds a number of VIP tasting events for our readers as well
as being involved in many charity tastings such as the Alfred
Hospital, Breast Cancer Research, Prostate Cancer and more.
At the same time exposing new wines to people who have
an interest in wine. We were very proud to have had nearly
800 different shiraz wines available for tasting at the World's
Greatest Shiraz Challenge public tasting at the National Wine
Centre in Adelaide each year. This is the biggest tasting of

its kind, with submissions from international producers, with
more entrants from France, New Zealand and South Africa.

At these Winestate Magazine Events we have over 500 wine
buffs in attendance sampling the full range of wines submitted
to our tasting. We do have a number of other events
throughout the year which we have arranged to coincide with
our tastings and have given these events to various charities as
fund raising opportunities. By creating these events it gives us
a further opportunity to promote those wines submitted to
tastings and encourage sampling of brands that many people
have not seen before. Many of the guests on the evenings
busily jot down shopping lists of what to buy when next
purchasing wine.




added value & promotions for wineries

the wine & spirit
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Point of Sale

Use copies of our Insider for your sales team to set up
promotional displays and prove to retailers that your products
are being promoted.

Third Party Endorsement

Our reputation of calling it how we see it, built up over more
than 3 decades gives your product the street cred and the
independent voice to move recommended products into bars,
restaurants, and liquor stores.

On line Promotions

We can run promotions on-line to add value to your
existing campaign. There are a number of different ways of
integrating our print and online services.

Wine Clubs

We often use surplus wines from our tastings for smaller wine
club tastings again exposing new wines to consumers who may
not have thought of sampling from those varieties or regions.

Advanced Trade Information

We send out our reviews in advance to Liquor retailers so
they can place orders prior to our publications hitting the
newsstands. Our list contains winery contact information so
it is easy for the stores to place orders. This is done usually
6-8 weeks prior to publication.

HOME  CURRINTISSUE | VNEREVIEWS | OODSTRAVIL VWANEROVICEWY  GETSHOP  NEWSSLVINTS  MEMDIRSARIA  CONTACT

Region | vaety | Edmon | Wy | TasngFAD

LOGN OR SUSCRIBE

Search the Wine Tasting Notes

St wearch weth: Elgaos | Macsty | Ediicn | wnsey

REGION

Adelade Hils -
Bavossa Valley & Eden Valley

Csteal & Westam Viclana

Centeal Viwstam Ausiraks

Clare Valey & Suunding Regions

Hustee Vabay

Limastoss Cosst

Makottugh

McLaren Vale, Langbome & Fleurieu

Mie Tosiand -

eyight WIMESTATE MAGAZNE




winestate publishing readership snapshot

: Places of Target Demographic
Readership o .
Distribution Audience Snapshot
Wi Newsagents 759 Male Skewed
ale Skewe
mes’rfﬁe 82,000 Subscriptions Wine Buyers 0
Magazine . . 25 -60 years of age
Wine Club Promotions
Inside Winestate
Wire & Saii Independent liquor stores 57% Mle
Inls?ger Pt 96 000 Chan Liguor Stores Wine Buyes 43% Female
Restaurants 18 — 45 years of age
(Aust, NZ, Singapore,
Hong Kong)
Winestate 94,935 . . 75% Male Skewed
; , Online only Wine Buyers
On-line page views per month 25 -60 years of age
C Tourism offices.
UST(,)m ) Variable on application ~ Point of Sale Wine Buyers Variable on application
Publications ,
On-ine
. , Wine Buyers , o
E-Newsletter Can be customised E-mail ' Variable on application
Trade Subscribers



WINESTATE,

readership profile

Average price paid for bottle of wine
Less than $10 8%
I'lto $20 44%
Age groups $lltod
Under 25 1% $21 to $50 42%
2510 39 28% More than $50 6%
40 to 54 49%
Total 100%
Over 54 12%
O,
Total |00% How frequently wine consumed
Male/Female Splits Daily 28%
Male 75% )
Several times per week 65%
Female 25%
O,
Total 100% Once per week 2%
Less than once per week 5%
Level of interest in wine
Beginner 9% Total 100%
Casual 25%
Serious 66% Relationship to Wine
Total 100% Consumer 69%
Trade Buyers 22%
Winery 6%
Winestate readers are influencers within Other 3%
their peer groups; as such the magazine
impacts on a wide-ranging audience. Total 100%
Particular areas of influence include wine
buyers, wine investment, wine tourism and :
Type of wine most often consumed
the restaurant scene.
Red wine 52%
White Wine 14%
About the same of each 34%
Total 100%




distribution winestate publishing

Winestate has a national and international circulation
base. Sold at news stands, bookstores, liquor stores and
by subscription, Winestate's sales concentration is in
the larger cities and their high-income suburbs.

Available at news stands in the UK, US, New Zealand,
China, Brazil, Singapore, Taiwan, Hong Kong and more.

Also available in the business lounges of with Qantas,
Virgin Australia, Malaysia Airlines, Singapore Airlines and
South African Airways lounges.

MarketAsia Singapore

Distributes across news stands in Singapore

Winestate Overseas Distribution

H USA BEUR B NZ OASIA E Other

Winestate Distribution by Country Winestate Distribution by Region

ENSW/ACT B VIC B SA/NT oQLb
HUSA EEUR B NZ OASIA B Other B Australia ETAS EWA B Overseas



star rating system

how we

Winestate Rating

2. 2.2.8.9.¢
*kkk1/2
22,28 ¢
*xx1/2
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tasting submissions & procedures

compare

Comment

Outstanding
Excellent

Very Good
Good/Very Good

Good

Tasting venues Tastings will be held at Winestate’s Adelaide
office unless otherwise notified. If tastings are to be held
elsewhere, companies will be advised by fax or e-mail of
revised dates and venue details.

Sample Quantities Please supply TWO sample bottles of
each wine. The second bottle will be used should the first
have fault. Prices Please provide RECOMMENDED RETAIL
or cellar door PRICES when submitting, and please indicate
clearly WHICH TASTING the samples are intended for as
well as your CONTACT DETAILS, PHONE, FAX, E-mail and
WEBSITE ADDRESS.

Tax Invoice for entry fee to be included with samples.

Awvailability All submissions must be bottled final blend. All
must be available to the public when the issue is published.

Regional Tastings Any wine, including fortified, is eligible,
provided that it has at least 85 per cent regional fruit content.

Style Tastings 85 per cent of a wine's fruit content must be
varietal for it to be tasted as STYLE; wines less than 85 per
cent varietal will be tasted as BLENDS within the class of
their dominant grape. Where blends of varieties are roughly
equal, please show whether the product should be tasted in a
varietal class, or as a generic blend.

New Release Tastings are open to any style, variety or region.

Submission documents are located at www.winestate.com.au

Wine show Medal Izrgi;ittlosr;iltem 100 Point System
Gold 18.5- 20 97 - 100

High Silver 18-18.4 95 - 96

Silver 17-17.9 93 - 94

High Bronze 16.5-16.9 91-92

Bronze 156.5-16.4 89 - 90

Wine judging is an inexact art, not a science - even at the highest levels of proficiency. Accordingly, Winestate uses the star rating
system which reflects arange, rather than a specific point score. Point systems indicate a level of accuracy that simply does not exist.
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tasting & special features 2018

Tasting
Submission
DEADLINE

early February

Tosting — the yine & spiri
Submission

DEADLINE insider

early January  New Releases

Tasting Submission
DEADLINE

Winestate Magazine
Style Features

Winestate Magazine

Regional Features

Fortified Wines
Sweet White Wines

Central & Western NSW
Hunter Valley

early February
early February early January
Western Australia* early January
Tasmania

Yarra Valley & Southern Victoria

North Island (Wairarapa, Gishorne, Auckland & Northland) *Qatar Airways Best of the West - PUBLIC TASTING 19th JANUARY 2018

McLaren Vale, Langhorne Creek early March ~ Cabemnet Sauvignon early April ~ New Releases early March
& Fleurie early February & Blends™
Kangaroo lsland Bordeaux Blend Varieties, early March early April

JuLy=re Adelaide Hills early Feb Merlot, Cab Franc, Malbec,

AUgUST R Petit Verdot
Organic Wines

South Island (Nelson, Canterbury) *World Cabernet Challenge VIII - PUBLIC TASTING 6th APRIL 2018
North East Victoria early April Shiraz/Syrah & Blends* early May — New Releases early April
Limestone Coast Pinot Noir (AUS) early April

SEP BMB R20 early April Pinot Noir (NZ) early June

Ctober Sparkling Wines
Otago (Central Otago & Waitaki Valley /Nih Otago NZ) *Mainfreight Infernational Worlds Greatest Shiraz/Syrah Challenge XII - PUBLIC TASTING 25th MAY 2018
Riverlands early July Gruner Veltliner early July  New Releases early July
Clare Valley early July Dry Riesling, early July
08 Queensland early June Sauvignon Blanc & Blends,
NOV MBERb Semillon
ecem er Pinot Gris/Grigio
Rosé

Hawkes Bay (NZ)
Wine of the Year Awards early September early August  New Releases early August
Taste-off Trophy Judgin early September early August  Spirits

ANNUALS ~ [oeofTosvldory ooty e B

Wine of the
Year Awards
Junuury/
February®*"

early August

*Wine of the Year Awards - PUBLIC TASTING 20th SEPTEMBER 2018

All the four- to five-star wines of 2018 in review.
Re-released in July 2019

See www.winestate.com.au for updates

*Tasting dates and deadlines are subject to change

2019 -M RCH
April

Barossa Valley, early O0ct 2018 Chardonnay & Blends early Oct 2018 New Releases early Nov 2018
Eden Valley ltalian & Spanish Varietals
Central & Western Victoria early Nov 2018 Emerging Varieties early Oct 2018

Marlborough (NZ)

For New Zealand regional tasting submission deadlines, please contact Kay Morganty - kmorganty@winestate.com.au

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212
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advertising rates

X(I){:IU]E i;{‘/é’;l;sfmrlﬁzzine Casual 3 x Rate 6 x Rate 9 x Rate 12 x Rate
Double page Spread $18,000 $14,000 $11,000 $10,000 $8900
Full Page $10,000 $8000 $6000 $5500 $4900
Half Page $5900 $5500 $5000 $4700 $2900
Third Page $3300 $3000 $2700 $2500 $1500
Quarter Page $2800 $1600 $1400 $1300 $890
|/8 PAGE CLASSIFIED SECTION | $595 $550 $495 $450 $425
Inside Front Cover $22,000 — Inside Back Cover $1 1,000 — Outside Back Cover $12,000

All rates subject to GST
the wine & SpimmSider Casual 3 x Rate 6 x Rate 9 x Rate 12 x Rate
4 Colour Advertisements
Double page Spread $24,000 $22,000 $19,000 $17,000 $15,000
Full Page $13,300 $11,600 $9900 $9000 $8000
Half Page $7600 $6560 $6600 $5500 $4500
Third Page $4900 $4700 $4400 $4000 $3700
Inside Front Cover $24,000 — Inside Back Cover $12,000 — Outside Back Cover $13,000

All rates subject to GST

Issuance & closing dates

Published last week of the month preceding date of issue. Inserts: Full run only / prices available on application.

Ad bookings close as published schedule.
Refer Booking & Material deadlines Page.

Frequency discount based on advertiser's contract year.

Advertisement composition, art, retouching, typesetting and

No cancellations accepted after closing date. other services as required will be billed to the advertiser.

Agency commission: (conditional on payment being made
within 45 days from receipt of invoice)

Material to be supplied by deadline otherwise publisher
reserves the right to repeat previous advertisement or charge
for space booked.

ONLINE ADVERTISING OPTIONS AVAILABLE WITH
BANNER ADVERTISEMENTS OR LINKS.

Preferred RHP (Right Hand Page) positions incur 10% loading.

Specific position requests upon application.

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212
e-mail sales@winestate.com.au website www.winestate.com.au
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booking & material deadlines

Booking Deadline Material Deadline ON SALE

MAB&prﬂ 12th January 27th January First week of March
MAY :
/June Ist March 8th March Last week of April
JUI.)( ~
A gust 21st April 2nd May Last week of June
SEP}&
ctober 26th June 4th July Last week of August
NOVEMBER
/December 22nd August Ist September Last week of October
4th October 19th October First week of December
ANNUAL &
Wine of Ihﬁ 24th November
JYeur AW;T S Special Material sizes L ol it
uguury 151h November please refe( fo: ast week of January
February ANNUAL Edition Re-Released July 2019
- artwork sizes or
www.winestate.com.au

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212
e-mail sales@winestate.com.au website www.winestate.com.au
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WINESTATE,

material requirements

These guidelines for supplying artwork to WINESTATE are designed to ensure our clients get the best possible print result.

If you have any further questions please do not hesitate to call your advertising consultant.

artwork sizes

Trim size with 5Smm bleed FOLD
Double page: 420mm wide x 297mm deep 430mm wide x 307mm deep
<—gutter
Insure type is 15mm from the gutter. Keep all important information 0mm from the top and bottom of your page.
Full page: 210mm wide x 297mm deep 220mm wide x 307mm deep
tt

Insure type is 15mm from the gutter, remember your advertisement could be on a left or right hand page. gutter
Keep all important information |0mm from the top and bottom of the page.
Half page vertical: 90mm wide x 270 mm deep N/A
Half page horizontal: [78mm wide x 135mm deep N/A
Third page vertical: 59mm wide x 270mm deep N/A
Third page horizontal: [78mm wide x 90mm deep N/A
Quarter page square: 90mm wide x |35mm deep

N/A
Quarter page horizontal: | 78mm wide x 68mm deep
|/6 page: 55mm wide x |35mm deep N/A
|/8 page CLASSIFIED: 87mm wide x 65mm deep N/A
the wine&spiritinsider cover specifications
Trim size with 5mm bleed

Allow 50mm from the top : o, e

210mm wide 220mm wide o allow for the mastheaFd)”, the wine & spiri mSId_e_[
x 297mm deep x 307mm deep i

Insure type is 1 5mm from the gutter. Keep all important information 50mm
from the top of the page and 10mm from the bottom of the page.

supplying images to WINESTATE

When sending images please DO NOT downsize the file

5mm bleed —

when e-mailing.

Artwork can be emailed directly to production@winestate.
com.au or by using a file sharing service such as Dropbox or
WeTransfer for large files.

v/ RGB JPGs, EPS and Tiff's will be accepted.

X DO NOT supply images in Word files or Power-Point.
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WINESTATE,

material requirements

ANNUAL EDITION ONLY

These guidelines for supplying artwork to WINESTATE are designed to ensure our clients get the best possible print
result. If you have any further questions please do not hesitate to call your advertising consultant.

artwork sizes - ANNUAL Edition

Trim size with 5mm bleed F(%l_D

Double page: 488mm wide x 305mm deep 498mm wide x 315mm deep

<—gutter

Insure type is 15mm from the gutter. Keep all important information |0mm from the top and bottom of your page.

Full page: 244mm wide x 305mm deep 254mm wide x 315mm deep

gutter
Insure type is |5mm from the gutter, remember your advertisement could be on a left or right hand page.

Keep all important information |0mm from the top and bottom of the page.

Half page vertical: |02mm wide x 274 mm deep N/A
Half page horizontal: 208mm wide x |37mm deep N/A
Third page vertical: 67mm wide x 274mm deep N/A
Third page horizontal: 208mm wide x 9 mm deep N/A
Quarter page: 02mm wide x |37mm deep

N/A
Quarter page horizontal: 208mm wide x 68mm deep
|/6 page: 68mm wide x 135mm deep N/A
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material requirements

supplying advertisements to WINESTATE

1 File Formats
We prefer files supplied as print ready PDF's. We also accept hi-resolution tiffs and eps files.
Native files must be provided with links and fonts.
If size permits you can e-mail advertisement to: production@winestate.com.au

2 Images
Each image you use should have the following attributes:
|. CMYK color mode
2. 300dpi (dots per inch)
Once the image has been converted to 300dpi and is the size you need it in the advertisement,
in Adobe Photoshop please view it at Actual Pixels (100%) (under View in main menubar).
At any percentage other than |00%, you're probably not seeing a fully accurate view of your image.

3 Flatten artwork and embedded fonts
All artwork should be flattened. Layers in Photoshop should be flattened and ALL transparencies
in InDesign flattened. All fonts must be embedded.

4 Gutter and trim
Make sure type is |5mm from the gutter, remember your advertisement could
be on a left or right hand page.
Keep all important information |Omm from the top and bottom of your page. —»

S Blacks
All black type must be 100% black. For example C=0% , M=0%, Y=0%, K=100% 0
(4 colour black will not be accepted) PAGE GUTTER
Solid blacks should be a rich black. For example C=20% , M=0%, Y=0%, K=100%

6 Hard Copies

Please provide a hard copy colour proof when supplying artwork.

/7 Always check your artwork in Adobe Preflight before sending to WINESTATE

See following page for more information.

8 Material to be supplied by deadline otherwise publisher reserves the right to repeat previous
advertisement or charge for space booked.

SPECIFICATIONS - covers

SPINE
|
\
INSIDE FRONT INSIDE BACK
TRIM: Width: 210mm TRIM: Width: 210mm
BACK COVER Height: 297mm Height: 297mm
TR':;m‘.jg;;rL?nmm BLEED: Width: 220mm BLEED: Width: 220mm
gt Height: 307mm Height: 307mm
BLEED:_ Width: 220mm *NOTE: |5mm gutter on *NOTE: |5mm gutter on
Height: 307mm right hand side. Please keep left hand side. Please keep
important information away important information away
from this area as it may get from this area as it may get
lost in the fold. lost in the fold.
| |
Smm bleed 5mm bleed GUTTER*
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WINESTATE

material requirements

Checking artwork in

Acrobat 7.0 Professional Preflight
This is a MUST before submitting supplied artwork.

1 Open your PDF in Adobe Acrobat 4 Click down on the information icon.
(version 7 shown in example). This will list all the images in pixels per inch and the
colour mode for all images. Please make sure all
2 Advanced (in main menubar) > Preflight images are 300dpi (ppi) and CMYK.

Preflight
[ Report ol Comments (@ it |Oprons =

b) Make sure Overprint Previewl|is ticked
@ Praflight check "List all imapes” found the following information:

Acrobat File Edit View Document Comments E Window Help 2] All pages from
DHSR - & A P Accessibility 3 ¥ @ Continucus tone image resokution higher than specified (1 match on 1 page)
= = Acrobat Distiller b i Summary
reate POF = S Camment & Markup = g Send for Review = () sechre Batch Processing... [#]Page 1: Cotor image 699.164x483.179 ot 300.0839 ppi CMYK (ICC) overprint: off
Catalog... B » 5L, Overview —
Digital Editions > i ¥ (B Brefight informatian
Export All Images...
T | X @ e - Forms >
JavaScrint >
e l' Links >
Migrate Comments...
Number Pages... |
POF Optimizer...
Security Settings...
Trusted Identities...
Web Capture [ 3

¥ show detailed information about document

v Use Local Fonts ey 7] Show selectsd page element in Saap view

 Overprint Preview (37 Boo Preflight
Quiput Preview...
+ Preflight... oRX 1D proties [ 9 Resdts| 1 heport < Comments (@ Eat | Optons -

@ Preflight check "List all mages” found the following information:

. ap I T Al pages from
3 Click on “List all Images” > Execute ¥ © Continuous tons imaga recolution higher than cpeciied {1 match on 1 page)
> i) Symmary
1 Ehge 1: Color image 615.335x551.258 pt 150.00609 ppi RGB overprint: of f
: > ?—L“ m“ I —————————
Prefiigh [ » ® Prefight information
i <l L Edit | Options * |

Select a profile for preflighting the current PDF:

Document generates more than two plates -~
List 100% black objects set to knock out
List »B85% black objects set to knock out
List all bitmaps |
List all images |
List bitmaps below 1000 ppi

List bitmaps below 300 ppi ¥ Show detailed information abeut document
List bitmaps below 600 ppi

List ductone images |_ Show selected page element in Snap view
List hairlines

List images below 100 ppi
List images below 120 ppi 1l
List images below 150 ppi

List images below 250 ppi

List images not CMYK

List images not CMYK or spot

List JPEG compressed images

List non B/W objects

List non CMYK objects

List objects using ICC/Lab/calibrated color .
i otk sheiden 5 Other things to check:
List spot color objects
List text using Courier inside Tnm/BloedBox L
List text using non-embedded fonts

List transparent cbjects <€— \

List non-embedded fonts > Execute
List transparent objects > Execute

L -

List white objects set to overpnnt
PostScript 3 support required

Purpese of the selected Preflight profile: \
Lists all images in the PDF file.

Preflight only pages 1 to 1
[ Execute )

PDF/X status of current document:

iﬁ_ Not a POF/X file.
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material requirements

Creating a PDF from

InDesignCS4

It is important to start the export process with a clean file.

Please make sure the document has been carefully proof
read, all colours are correct, all fonts available and images
are linked properly.

This can be checked in InDesignCS4: File>Package

File menu > export

2 Saving your Adobe PDF.

Select the location you would like to save your PDF,
create a file name and > save.

2 General

Select 'WINESTATE' from the Adobe PDF Preset drop down menu.
If this is the first time creating a PDF for Winestate, follow all the steps
first and click on ‘Save Preset’ before you click Export.

T

Seve Preset As.  WINESTATE

Select PDF/X-4:2008 from the Standard drop down menu.

3 Compression

Colour Images > select ‘Bicubic Downsampling to’
from the drop down menu > 300 Pixels per inch
for images above > 450 pixels per inch
Compression > Automatic (JPEG)

Image Quality > Maximum

Greyscale Images > select ‘Bicubic Downsampling to’
from the drop down menu > 300 Pixels per inch
for images above > 450 pixels per inch
Compression > Automatic (JPEG)

Image Quality > Maximum

Monchrome Images > select ‘Bicubic Downsampling to’
from the drop down menu > 1200 Pixels per inch

for images above > 1800 pixels per inch

Compression > CCITT Group 4

Select > Compress Text and Line Art.
Select > Crop Image Data to Frames.

oo L
Adobe POF Preget: -
Ssandard: POF/X-A:2008 - Compatbdty: Acrobat 5 (POF 1.4} -
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Compresson;  Auvtomats [IPEG)

- The Szes [128

Frage Qualty: Madmum

Monchiorme Images
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Select Acrobat 5 (PDF 1.4) from the Compatibility drop down menu.

for images ahove: 1800 | phiek i nch

Compresson: CCITT Group 4 -
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Sty content auchange. For more information on creating POFX- P 4 Mar‘ks and Bleeds
Sy
o Click ‘All Printer's Marks will select all marks for the PDF.
3-.::;‘ Click ‘Use Document Bleed Settings’ should be set at 5mm
= around the entire document. FILE > Document Setup > Bleed.
| Erbad Page Thumbnat | e POE ater Exportng *Only add bleed if you are sending a full page, double page,
| Gotrrme for Fast Web Create Acrobat Liyer .
oo NedpOF A or cover advertisements.
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RO = or a half or third page vertical you do not require bleed.
ks Set Offset to 4mm.
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material requirements

Creating a PDF from

InDesignCS4 cont.

5 Output 7/ Security
Colour Conversion should be set to No Colour Conversion. Does not need to be created.
Inks — The only inks showing should be Process Cyan,
Magenta, Yellow, Black. If you have other colours showing,
you need to go to the Ink Manager button, and check on

Adobe POF Preget: WINESTATE
the All Spot to Process box.

Standard: POFX-4:2008 Comoatiiley:  Acrobat 5 (POF 1.4}
sequrty
- Encryption Levet Migh (128-b RCS) - Compatible with Acrobat § and Later
i Export PDF Ducument Opan Paseword
Adobe POI| Preget: WINESTATE e Fequr 3 paseward B0 open the document
FOF4:3008 - Lomp! c Acrobat 5 (POF 1.4) - Rocument Open Password:
== Al Permissions
ks e I Use a passeord 0 restrict printing, eding and other tadks
12 Coolr Cor ks Parmissions Password:
e Destration: | H/A - e
- Brofie Inclusion Poley? | Incude Al RGE and, Tagged Source (¥ +
Prowng Alowed:  Hgh Ressuton
Simutate Qvempant Y Ik Manager... | Changes Mlowed: | Any exceot extractng pages
POFIK Enabl copying of text, images and other content
Output Inkent Profie Name: Coated FOGRASD (150 12647.2:20 = Enabile text access of screen reader devices for the veualy impared
utzt Condin Name:
‘Gutput Condtion Tdantfer:
Eegstry Name:
Deserotion
Pusitun e puirier wrer @ ey b view & deeeten.
S et o ] = | 8 Summary
Make sure nothing issues with creating your PDF under the
Options list.
Expart Adobe PDF
Adaba FOF Preget: WINESTATE -
[ho ik Satnced] Spandaid: POFMX-4:2008 s Compathiky:  Acrobat § (POF 1.4) -
Irow: v - ] Summay
Neutsal Deraty: | Compraman. T
Traspng Sequences e WM:M:‘;E‘""““‘”.’;;“‘_1M“‘“”“_1 -
Ik Aot | Mo Adaa] | cumper 51w chacn o st ok 12 BORTALZO08, 0 150 st br ot comtmre. =)
e = - PR b, Fos ey oy 7 i PO corclt FOF decomrts. s
[Mispotstadooms || Use Standard Lab Valess fir Spocs Sanrry
Sy |

B Advanced
Job Definition Format should be un-ticked.

Export Adobe PDF
Adobe PDF Preget: WINESTATE -
Spandard: POF/X4:2008 - Gompatblty: Acrobat 5 (PDF 1.4) =
=] Advanced
Macts ol s -
s Subsat fonts when percent of charcters used & less than: 100%
A 1o s e b i by ambacind.
s Pl
Swmemary
Ome for OPE: {1 FOF Bmap Images 9 Save and export PDF
T T A. If you regularly send artwork to WINESTATE Save Preset.
Praset: | [Hgh Ressiubon] - . .
onore Saread Overides Next time you can skip all the above steps.
frition
:T:;“ umﬁ;m B. Export your PDF after you have gone through all the tabs.
¥ :.“hwwhhw“
10  Check PDF in Acrobat Preflight > See relevant page
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online

winestate on-line

Our online site is used by wine connoisseurs globally to
research information about the best of Australian wines.

Many of the users of our website are current subscriber to the
magazine or use the site for latest news.

Rankings on most search engines puts it generally in the top
|0 wine sites.

We have consistently maintained an average of | | million hits
per annum on the site.

There is a number of exciting user friendly functions on our
site for wine buyers/consumers to use. These include access
to stories as well as sort functions for wine reviews by region,
variety, winery, vintage & price.

We currently have around 12,000 reviews on this site going
back to 2008. Around 0% are viewed for free with out log
in and an additional 25% can be viewed simply by registering
details (still free) To access the remaining reviews users of the
site can subscribe to a paid subscription.

All the reviews that are viewed for FREE are the reviews in the
magazine with either bottle or label shots supplied alongside
the review. In addition these reviews have the winery website
details and contact e-mail below the actual review.

winestate magazine on-line

* More than | Million page views each vyear.

* Nearly |'| Million Hits each year.

* Over 94,935 page views per month.

* Over 3000 page views per day.

* Over 18,000 unique user sessions per per month.
* Over 216,000 unique user sessions per annum.

* Active database of newsletter subscribers.

www.winestate.com.au
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www.winestate.com.au - RATE CARD

Sponsored Links on Home Page

*
6 month minimum $500 per month

Links $500 per year*

Premium Links with Logo $1500 per year*

Direct Marketing via our

. P.O.A
Winestate e-newsletter

All rates shown are GST exclsuive

*Can be supplied free of charge if print advertising is purchased.
Contact sales@winestate.com.au for details.

Some Key Points:
* More than | Million page views each year.
* We can run banner advertising.

* Packages for banner ad placement & for links available.



digital

Winestate, Australia’s longest running wine magazine, has gone digital with the help of
one of the world's most pre-eminent digital reader companies, Zinio. www.zinio.com

T

-
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N |

i DO OEEQ GHO BF= 06

s prere and wubnerioe 1 Weeststs 51
WWww.winestate com.au

So why are we so excited about Winestate Digital?

Well, because it's a fantastic complement to our print version.

Winestate Digital allows for greater interactivity, so whether
you are perusing our Grapevine section and spot a great
restaurant that you would like to check out, or are searching
our contact details page and want to get a direct link to that
winery, it's all available at the click of a button.

Winestate Digital offers ease of use.

For those with sight impairment or who just want an easier
read, that's not so hard on the ol' peepers, Winestate Digital
has a zoom function that makes it very comfortable.

A search function is also available for when you just can't
remember where you saw that elusive wine or topic of
interest in your current issue.

Winestate subscribers who live overseas no longer have to
wait to get their issue, they'll receive it the same time that
Winestate hits newsstands here!

This makes giving Winestate Digital as a gift for friends and
loved ones a great ideal

Log on to www.winestate.com.au subscribe now!
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Advertising Policies and Content Guidelines

All Advertiser Content must be in good taste and must comply with all laws, rules and regulations that apply to the Advertiser, the
Advertiser Content and any location where the advertisements may appear.

The landing page must prominently present the offer being advertised. Example: If the advertisement offers 25% off, then the landing
page must feature the products that are 25% off.

Non-specific calls to action (e.g. “Click here”) are not allowed. Specific calls are acceptable.
Advertising promoting sweepstakes may or may not be allowed, subject Winestate Magazine’s prior written approval.
Advertising “free”” goods or services must indicate that terms and conditions apply.

The following advertising and advertising content is prohibited:

Pornography and other “adult” content.

llicit/illegal drugs and drug paraphernalia.

Gambling or gambling paraphemalia, including online gambling, poker, or bingo.

Tobacco or tobacco related products.

Weapons, including guns, gun parts, kits, mace, nunchucks, halberds, blank powder and ammunition.
Foul, vulgar or obscene language or that features nudity.

Content that is defamatory, libelous, invasive of another's privacy.

Hate speech - inciting or advocating violence or racial intolerance.

Content that is threatening, abusive, harassing, or advocate against a protected group, whether based on race, color, national origin,
religion, disability, sex, sexual orientation, age or any similar or other category.

Content that promotes any illegal or dangerous activity.
Deceptive, false or misleading content.

Content or technology that infringes, or encourages or enables the infringement of, the intellectual property or personal rights of
others.

Technical Specifications - General Technical Guidelines

Advertisements must not collect any information from or about individual users (whether or not such information is personally
identifiable) without Winestate Magazine's prior written consent.

All advertisements must be in-banner and not expand, either automatically or by mouse roll-over.

All advertisements must not include pop-ups and pop-unders, nor may landing pages spawn pop-up or pop-under advertisements to a
user.

Winestate Magazine does not allow ads with flashing, a lot of animation, “fake winner” copy or fake functionality such as HTML Selects
or “Search Forms” in HTML or Flash or image format.

If an advertisement uses third party tags, please include specific trafficking instructions. A contact at the third party is required and must
be provided to Winestate Magazine prior to the campaign.

All impression delivery and billing will be based on Winestate Magazine reporting numbers unless otherwise specified in the applicable
insertion order.

If Advertising Content is late or do not meet guidelines noted herein, Winestate Magazine reserves the right to extend the campaign
by the number of days the Advertising Content was late in order to reach the contracted impression goals. However, Winestate
Magazine will work with the applicable advertiser or agency to deliver all impressions within the contracted flight dates pending
placement and available inventory.

Advertisements may not use Winestate Magazine or Winestate logos or trademarks or mention or refer to Winestate, its site or its
brand in any manner without Winestate Magazine’s prior written consent.

Ads must incorporate advertiser's trademark. The messaging should not mislead the user.

Advertisements must not interfere with navigation on Winestate Magazine website, obscure other content or advertisements, access
or alter computer settings or preferences or otherwise unduly or inappropriately interfere with the user's experience of or Winestate
Magazine's operation of Winestate Magazine websites.

Advertisements must not trigger downloads of software to a user's computer without first providing the user with clear and
conspicuous disclosures regarding the installation, operation and removal of the software, and providing the user with an opportunity
to decline to install the software after such disclosures are made

The display URL must be the actual destination URL (i.e., the website that the advertisement’s link resolves to, not a redirect) of the
advertisement so that it informs the user of the destination website of the advertisement.

The destination URL of an advertisement must work properly and resolve to a working website. It cannot connect to an email address
or file, and must not be under construction.
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WINESTATE

website banner adverts
material requirements

Winestate, Australia’s longest running wine magazine is online at www.winestate.com.au.
To maximise your impact to your target audience and successfully advertise and market your
business why not place a banner advert on our website. For website advertising inquiries
please contact: sales@winestate.com.au

WINESTATE,

FOOD & TRAVEL -~ WINE TUTOR - WINE REVIEWS SCRIPTIONS
1 CLICK HERE
’ COLOUR TO SUBSCRIBE
CONSCIOUS
3 ’

COLOUR CONSCIOUS

VISIT US AT
MICHAEL HINCE SURPRE glven its ubl n e.. pulpitcellars.com.au

click

sqgem-uaaibssow

EXPORT BOOM CONTINUES blink

CHINA continues ta boom as Australia’s most valuable wine expert market. In
2016, exports to mainland China grew by 40 per cent to a record 5520 million,
A decade ago, Australian wine exports to China were valued at 527 millien....

See the latest tasting reviews
here... | Wiew a list of all

518 reviews available without login >> | wines tasted in
0 reviews available for FREE members >> |/ the current lssus
4260 reviews available for subscribers »> | [P

Banner ads can be either created or designed by your

own graphic design or marketing department or with the
Winestate Inhouse designer at a cost (contact production@
winestate.com.au).

[€¥]

Website Banner Ad Specs:

All Banner ads must be within the specs listed below.

¢ Resolution to be 72 DPI

"-

YOUR YOUR
.« RGB | Online Banner Online Banner
colour ADVERT HERE  ADVERT HERE

» Sized at 160 pixels wide x 600 pixels high

* The file can either be a png or jpeg file or it can be an
animated gif file.

* All banner ads must be linked to a company website,
please provide a website for linking.

* Artwork can be emailed directly to production@winestate.
com.au or by using a file sharing service such as Dropbox
or WeTransfer for large files.

Advertise Members Buy a Gift
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WINESTATE,
STICKERS ORDER FORM

STICKERS PRICE per 1000 @ $42.00 (incl GST if applicable)

Price negotiable for large orders, contact sales@winestate.com.au

lafoldel 5 STARS ok X
WINESTATE, WINESTATE

4 V2 STARS

N Qy < ey Qy
‘q

Gaz Gaz

®©
Py
Q

Recommended by Winestate m 4 STARS
WINESTATE

't 4 STARS t

Qty M Qty

Best Value Buys $20 & Under Best in Class
't

Wine of the Year

Trophy Winner

Qty

SUB-TOTAL | $

STICKER ARTWORK IS ACTUAL SIZE Postage $

Prices are in Australian Dollars (please contact us for postage prices as they will vary). TOTAL
See contact details section below. $

DELIVERY DETAILS

Company Name

Contact Name

Postal Address for stickers

Postcode

Postal Address for invoice

Postcode

CONTACT DETAILS

Please send Australian order form to: F: +61 8 8357 9212 | E:sales@winestate.com.au

Please send NZ order form (GST free) to:  F: 09 479 1253 | E:kmorganty@winestate.com.au

Please send South African order form (GST free) to: F:+61 8 8357 9212 | E:sales@winestate.com.au
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editorial calendar

2018/2019
Winestate Magazine Winestate Magazine e e
Regional Features Style Features he vine & spit mSIder A0 LA
Barossa Valley, Eden Valley Chardonnay & Blends New Releases 9nd week
MA Central & Western Victoria ltalian & Spanish Varietals
o January
BXPHI Emerging Varieties
Marlborough (NZ)
Wines of NSW New Releases
McLaren Vale, Langhome Creek 4th week
MAY & Fleurieu Februqry
/ June Western Australia
North Island (Wairarapa, Gishorne, Auckland & Northland)
Yarra Valley & Southem Victoria  Cabernet Sauvignon New Releases
River Regions & Blends
Adelaide Hills Bordeaux Blend Variefies,
Merlot, Cab Franc, Malbec 3rd week
Clare Vall ' ' '
JUI% qre Yy Petit Verdot April
August Organic Wines
Fortified & Sweet White
Wines
South Island (Nelson, Canterbury)
North East Victoria Shiraz/Syrah & Blends New Releases
Limestone Coast Pinot Noir (AUS) 3rd week
SEP}B Kangaroo Island Pinot Noir (NZ) June
ctober Tasmania Sparkling Wines
Otago (Central Otago and Waitaki Valley, in North Otago)
Dry Riesling & Blends New Releases
Sauvignon Blanc & Blends  Spirits
Queensland Semillon & Blends
ot GG 3rd week
NOV MBER |n0’ tis/ Grigio August
/December Rost
Emerging Varietal Awards
(EVA)
Hawkes Bay (NZ)
Wine of the Year Awards Global Gruner Challenge New Releases | K
ANNUAL & Taste-off Trophy Judging Results st wee
Wine of the October
Year Awqrds Al the four- to five-star wines
January/ ofthe year in review. See www.winestate.com.au for updates
Febl’U(]l’y Reveleased in July 2018, *Tasting dates and deadlines are subject to change

Winestate Publishing 8| King William Road, Unley 506 South Australia, phone (08) 8357 9277 fax (08) 8357 9212
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